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About this Manual 

This manual describes how to use the Metago® Monitor application. 

The manual is divided up into chapters, with the first three describing the Metago® Monitor 
application, installation procedure, and how to connect and log in. The remaining chapters 
cover more specific features of the application. 

Conventions Used in This Manual 

Commands, steps, and explanations in this manual are presented in the clearest format 
possible. The following items are some of the features that will make this manual more easily 
readable: 

• Menu and dialog box commands and options. Menu and dialog box commands are in 
bold.  i.e. Open the File menu and click Save. 

• Hotkeys for commands. The underlined keys onscreen that activate commands and 
options are also underlined in the manual, as shown in the previous example. 
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Overview 

Metago® Monitor application is used to remotely monitor all connected RTUs. 

Metago Monitor can perform the following operation for each connected RTU: 

• Issue basic TL-1 commands, such as retrieve IP, retrieve router, retrieve firmware 
version, and retrieve alarms. 

• View all the alarms (critical, major, minor, and routine) for the connected RTUs in the 
Alarm Summary display. 

• Issue discrete controls on an RTU. 

• View the log file on any RTU that was connected to via Metago® Monitor. 

• Configure access to the Metago® Monitor web browser interface on any RTU being 
monitored. 

 

Chapter 
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System Requirements 

To run the Metago Monitor , the system requirements are: 

• Windows 98/ME/XP/2000 operating system 

• Microsoft Internet Explorer 5.5 +, or Mozilla Firefox 

• Pentium 500 MHz or faster microprocessor 

• A minimum of 128 MB of RAM 

• CD-ROM drive (for installing application) 

• A mouse, or other pointing device 

• Network connection 

Installing the Metago® Monitor Application 

The Metago® Monitor application is installed using a standard Windows installation utility.  

To install the application,  

1. Insert the installation CD into the CD-drive. 

2. If the PCis configured to AutoPlay CDs, the installation utility should be launched 
automatically, skip to step 5. 

3. Open My Computer, and browse to the CD-ROM drive. 

4. If the CD does not autopaly, double-click on the file SETUP.EXE.  

5. The installation program will guide you through the subsequent steps. Simply follow 
the instructions as they appear on the screen.  

6. Select Finish when the installation process is completed. 

Chapter 
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Logging On 

To access the Metago® Monitor application, 

1. Click the Start button in the taskbar at the bottom of the screen. 

2. Move the mouse pointer over the Programs command. The Programs menu appears. 

3. Move the mouse pointer over the Westronic command and click the Metago® Monitor 
item. The Metago® Monitor Login dialog box appears. 

 

4. Enter a valid User name and Password in the fields provided. Click OK to log on. The 
RTU Summary display appears. The default user name is MTC and password is shipping.  
Usernames and passwords are case-sensitive. 

Note: This username and password is independent from the WS3500 RTU username and 
password. 

 

Chapter 
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Figure 1 Metago® Monitor – RTU Summary display 

By default, Metago Monitor starts by displaying the RTU summary.  The tabs at the top of the 
main window allow for easy navigation between the following Metago Manager screens : 

• RTU Summary tab — displays the RTU Summary. From this display, the user can create 
and delete RTU records, connect and disconnect to RTUs, issue basic TL-1 commands 
such as retrieve IP, retrieve router, retrieve version, and retrieve alarm. 

• Alarm Summary tab — displays the Alarm Summary. The Alarm Summary display lists all 
the points in alarm for all currently connected RTUs, as well as “NOT CONNECTED” 
alarms for all RTUs that are not currently connected. In this display, the user can 
acknowledge alarm points, add/delete comments on alarm points, acknowledge the 
audible on an alarm point, and inhibit alarms. 

• Control tab — in the Controls display, the user can issue controls on any of the connected 
RTUs. 

• RTU Raw Data tab — in the RTU Raw Data display, the user can view the TL-1 
messages and commands on a selected RTU. This display also shows the total number 
of alarm messages for all connected RTUs. 
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RTU Summary 

The RTU Summary display is used to manage connectivity with RTUs in the field. In this 
display, the user can  

• Create and delete RTU records. 

• Connect and disconnect to RTUs. 

• Issue basic TL-1 commands such as retrieve IP, retrieve router, retrieve version, and 
retrieve alarm. 

• Filter the RTU list based on TID and/or IP Address. 

 
Figure 2 RTU Summary display 

Creating an RTU record 

To create a new RTU record, 

1. Click on the New RTU button in the RTU Summary display. The New RTU dialog box 
appears: 

Chapter 
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2. Enter the TID and select LAN or Modem, then input either the IP Address or Dial-Out # 
(also change the port or Interval settings as desired) and then click OK. 

• TID —Enter the TID (target identifier) of the RTU to monitor. 

• IP Address — enter the IP Address of the RTU to monitor. 

• Port  — enter the IP Port of the RTU to monitor. 

• Dial-out # — enter the dial out number of the modem RTU to monitor. 

• Interval (minutes) — enter the period of time in minutes between dial out attempts to 
modem RTU being monitored. 

Metago Monitor now has all the information that is necessary to connect to and monitor the 
RTU. 

Deleting an RTU record 

To delete an RTU record, 

1. Select the RTU record in the summary grid. 

2. Click the Delete RTU button. This calls up a dialog box to confirm the deletion of the RTU. 

 

3. Select OK to continue this operation (Cancel will abort the deletion). 

Filtering the RTU Summary List 

In order to quickly find an RTU, the summary grid, can be filtered based on the TID and/or IP 
Address. 
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To filter the list, 

1. Click on the Filter RTU Summary check box. 

2. Enter the filter definition.  

To remove the filtering un-check the Filter RTU Summary check box. 

Editing an RTU record 

Only edit the IP Address and Port number (Or Dial-out # and Interval) on an RTU can be 
edited.  These fields cannot be edited while the RTU is connected. 

To edit an RTU record, 

1. Select the RTU in the Summary grid. 

The information for that RTU is displayed in the Edit RTU Information panel. 

 

2. Modify the desired fields. 

3. Click the Save button to save the information. 

Connecting to an RTU 

To connect to an RTU, select the RTU in the summary grid, and then click on the 
Not Connected button. Upon a successful connection, the Not Connected button reads 
Connected.  

The RTU record in the summary grid is displayed in three different colors: 

• Red — indicates that the RTU is not connected  

• Blue — indicates the connection is pending, or the unit is being polled (if a dial-up RTU) 

• Green — indicates that you are connected to the RTU 

Warning: It is possible to establish a TCP/IP connection to an RTU, and not successfully 
establish a TL-1 session. This can occur if the TID specified in the Metago® Monitor does not 
match that of the RTU itself. 
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Disconnecting from an RTU 

To disconnect from an RTU, select the RTU in the summary grid, and then click on the 
Connected button. Upon a successful disconnection, the Connected button reads Not 
Connected. The RTU record in the list will be displayed in red text and the Disconnect Time 
for that RTU will be updated in the summary grid. 

TL-1 Commands 

Metago Monitor can issue several TL-1 commands to a connected RTU, using the buttons on 
the RTU Summary display. 

Issuing the Retrieve IP command  

The Retrieve IP command is used to obtain the currently configured IP addresses for the RTU, 
and the Line Modem.  There is also a reserved (RSVD) IP address which is not currently used. 

1. Connect to the RTU or select the connected RTU from the summary grid. 

2. Click on the Retrieve IP Address (RTRV-IP) button. A dialog box appears which displays 
the name of the RTU, along with the Config (RTU) IP address and the Modem IP address. 
(The RSVD IP ADDRESS is not currently used, and can be ignored.) 

 
 

Issuing the Retrieve Router command  

The Retrieve Router command is used to obtain the currently configured Router/Gateway and 
Netmask addresses from the Metago® RTU. 

1. Connect to the RTU or select the connected RTU from the summary grid. 

2. Click on the Retrieve Router (RTRV-ROUTER) button. A dialog box appears which 
displays the name of the RTU along with the Router and Netmask addresses. 
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Issuing the Retrieve Version command 

The Retrieve Version command is used to obtain the current firmware version running in the 
Metago® RTU.  

1. Connect to the RTU or select the connected RTU from the summary grid. 

2. Click on the Retrieve Firmware Version (RTRV-VER) button. An Information pop-up 
window appears which displays the name of the RTU and the version of firmware running 
in the RTU. 

 

Issuing the Retrieve Alarm command 

The Retrieve Alarm command sends a request to the RTU to report all points that are currently 
in an alarm state. This is most useful following a reconnection to ensure that the Alarm 
Summary reflects the current state of all points in the RTU.  

In the Alarm Summary display, when an RTU is connected, the background color of the 
alarms indicates the alarm priority. When the RTU is disconnected, these alarms are marked 
as old, and are then displayed with a gray background. To clear the alarms as being marked 
old, you must connect to the RTU and issue a Retrieve Alarm command. 

1. Connect to an RTU or select the connected RTU from the summary grid. 

2. Click on the Retrieve Alarms (RTRV-ALM) button.  

Note: there is no confirmation indicating the command has been completed. 
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Alarm Summary display 

To view alarms from all the RTUs, select the Alarm Summary tab. This displays the Metago 
Monitor Alarm Summary. 

 
Figure 3 Alarm Summary display 

By default, the alarms listed in the Alarm Summary are grouped according to severity, with 
critical alarms listed first, then major, minor, and routine. Points with a severity of NA are never 
displayed. Within each severity the alarms are listed in chronological order, the newest alarm 
at the top of the list. 

The alarms in the Alarm Summary may be sorted (ascending or descending order) by clicking 
on any of the headings (TID, AID, etc.). An arrow indicates whether the list is sorted in 
ascending or descending order. To remove the sorting click on the heading until the arrow is 
removed. 

Chapter 
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Description Alarm Color 
Critical alarms Red 
Major alarms Orange 
Minor alarms Yellow 
Routine alarms Blue 
Old Alarms* Grey 
Alarms that have cleared, but are latched** White 

Table 1 Alarm Colors 

* Old alarms are alarms that may not necessarily be up-to-date because you are either not 
monitoring that RTU anymore, or you were monitoring the RTU when the alarm initially 
occurred, but you have since disconnected from that RTU. To clear up any old alarms, the 
user should issue a retrieve alarm command immediately after connecting to an RTU. 

**Latched alarms will still appear in the alarm summary until their latching condition has 
cleared (refer to Alarm Latching on page 29). 

Within the Alarm Summary display, the user can  

• Filter the alarm summary base on specific criteria. 

• Freeze the Alarm Summary display. 

• Acknowledge the alarms individually or ALL the alarms at once. 

• Unacknowledge individual alarm points. 

• Add / Edit comments to alarm points. 

• Inhibit alarms 

• Retrieve alarms from all commected RTUs 

Filtering the Alarms 

The alarms listed in the alarm summary grid can be filtered with many combinations of different 
criteria.  

To enable alarm summary filtering, the user must first click the Settings button to configure the 
filtering criteria.  When the Settings button is clicked, the Filter Settings window appears. 
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Any combination of filtering criteria can be selected by checking the checkbox beside the 
desired item, and selecting the options associated with that option. 

• Filter alarms by Acknowledgement – A user can select to show only acknowledged 
alarms, or to show only unacknowledged alarms. 

• Filter alarms by Comment – A user can select to show only alarms with comments, or 
to show only alarms without comments. 

• Filter alarms by Severity – A user can select a severity from the drop-down box, and 
only alarms of the selected severity and higher are displayed in the alarm summary. 

• Filter alarms by SID – A user can select either to show or to hide alarm based on the 
SID field.  Partial SID strings can be used, and multiple values can be entered, 
separated by commas. 

• Filter alarms by AID – A user can select either to show or to hide alarm based on the 
AID field.  Partial AID strings can be used, and multiple values can be entered, 
separated by commas. 

• Filter alarms by Location – A user can select either to show or to hide alarm based on 
the Location field.  Partial Location strings can be used, and multiple values can be 
entered, separated by commas. 

• Filter alarms by WG – A user can select either to show or to hide alarm based on the 
Workgroup (WG) field.  Partial WG strings can be used, and multiple values can be 
entered, separated by commas. 
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Click the Apply button on the Filter Settings window to accept these changes. 

To apply the filter criteria selected above, click the Enabled option in the Filter Alarms panel. 

To disable the filtering, select the Disabled option in the Filter Alarms panel. 

Retrieve All Alarms  

The Retrieve All Alarms button allows the user to quicky retrieve all alarms from all 
connected RTUs.  Once all alarms have been received, the Alarm Summary display is 
updated to reflect any changes that may have occurred. 

Freezing the Alarm Summary display  

The Alarm Summary display is updated when any alarm changes state, and the alarms may 
reposition in the list following this operation. To prevent this from happening, select the Frozen 
radio button, and no new alarms will be displayed.  

To release the display, so new alarms get reported, select the Active radio button. Alarms that 
were reported or cleared while the display was frozen will then be added to or removed from 
the display. 

Acknowledging Alarms 

To acknowledge alarms individually, with the left mouse button, click on the Unacknowledged 
alarm icon beside the point you wish to acknowledge in the Alarm Summary page OR with the 
right mouse button, click on the alarm point in the Alarm Summary. A pull-down menu 
appears, select Acknowledge Alarm. A green check mark icon appears, indicating the alarm 
has been acknowledged. 

To acknowledge all the alarms listed in the Alarm Summary display, click the ACK ALL button. 
Green check marks appear on all alarms, indicating that they have been acknowledged. 

In addition to acknowledging alarm points, an Administrator may also latch all alarm points that 
have not been acknowledged (refer to Alarm Latching on page 29). If Latch unacknowledged 
alarms is enabled and an unacknowledged alarm point clears, the point remains in the Alarm 
Summary list (white background), until the alarm point is acknowledged. 

Unacknowledging Alarms 

To unacknowledge an acknowledged alarm, with the left mouse button, click on the Alarm Ack 
icon beside the point you wish to unacknowledge in the Alarm Summary page OR with the 
right mouse button, click the alarm point in the Alarm Summary display. A pull-down menu 
appears, select Unacknowledge Alarm. The green check mark disappears for all alarms in 
the display. 

Adding a Comment to an Alarm Point 

To add a comment to an Alarm Point, do the following: 
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1. With the right mouse button, click on the alarm in the Alarm Summary display. A pull-down 
menu appears, select Add/Edit Comment. The Edit Comment dialog box appears; OR 
with the left mouse button, click on the Comment column associated with the alarm point 
The Edit Comment dialog box appears. 

 
2. In the Comment area, type a comment for the alarm point. 

3. Click Save to save the comment. A comment icon will appear next to the Alarm point. 

In addition to commenting an alarm, an Administrator may also latch all alarm points that have 
comments (refer to Alarm Latching on page 29). If Latch alarms with comments is enabled 
and an alarm point with a comment clears, the point remains in the Alarm Summary list (white 
background), until that comment has been deleted from the alarm point. 

Deleting a Comment on an Alarm Point 

To delete a comment on an Alarm Point, do the following: 

1. With the right mouse button, click on the alarm in the Alarm Summary display. A pull-down 
menu appears, select Delete Comment. The Edit Comment dialog box appears; OR with 
the left mouse button, click on the Comment column associated with the alarm point The 
Edit Comment dialog box appears. 

 
2. Click the Delete button. A confirmation box appears: 
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3. Click OK to delete the comment. 

Inhibiting Alarms 

In the Alarm Summary display, a user can inhibit nuisance alarms. When the alarm is inhibited, 
the entry is removed from the Alarm Summary display and placed in the Inhibited Alarms 
display. For more information on the Inhibited Alarms display refer to page 39. 

Inhibited alarms will not be displayed in either the Alarm Summary or Metago® Monitor web 
page. To inhibit an alarm point, with the right mouse button, click on the Alarm in the Alarm 
Summary. A pull-down menu appears. Select Inhibit Alarm. The alarm point will be removed 
from the Alarm Summary display and Metago® Monitor Online Alarm Summary, and will be 
displayed in the Inhibited Summary. 
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Controls 

Issuing controls requires the user to login into the RTU with a username and password. 
Once successfully logged on, the user may issue several controls on that RTU. 

The user is automatically logged out from the RTU when exiting the Controls tab (the TL-1 
command CANC-USER is issued). To remain in the Control display, but to log out of the 
selected RTU, click on the Logout button. 

Issuing Controls 

To issue a control,  

1. Select the Controls tab. This displays the Controls sheet: 

 

Figure 4 Controls sheet 

Chapter 
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2. Select the RTU. 

The pull-down button contains a list of all the RTUs that are currently connected. 
Select the RTU on which to operate or release a control. 

3. Login to the RTU. 

Enter a valid Username and Password and then click the Login button.  

If the login was successful, the username and password fields become deactivated 
and the Login button now reads Logout. 

4. Select the control point you wish to issue or release. 

• Point AID — enter the point AID of the control point OR select the point from the 
most recently used list.  

• Control Type — the pull-down menu contains the three control types, LATCH, 
MOMENTARY, and FLASH. Select the appropriate type. 

5. Click Operate or Release to issue the control.  

A message in the Control Status panel indicates whether the control was successful 
or not. 
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RTU Raw Data display 

To access the RTU Raw Data display, select the RTU Raw Data tab in the RTU Summary 
display. 

 

Figure 5 RTU Raw Data display 

Within the RTU Raw Data display, a user can 

• Display the autonomous TL-1 messages sent by a specific RTU to the host and the TL-1 
commands sent to and from the RTU. 

• Print the messages displayed in the RTU Raw Data window. 

• Reset the alarm count. 

Displaying the autonomous TL-1 messages and commands 

To display the autonomous TL-1 messages and commands for a specific RTU, select the RTU 
from the pull-down menu button and click the Enable Raw Data checkbox. All autonomous 
messages and commands associated with that RTU will be displayed. 

To disable this feature, click Enable Raw Data checkbox to remove the check mark. 

Chapter 
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Printing the Raw Data messages 

To print the autonomous TL-1 messages and commands displayed in the RTU Raw Data 
window, click on the Print Raw Data button. 

The user may select a specific message or range of messages to be printed by highlighting the 
text in the Raw Data display, and clicking the Print Raw Data button. When the Print dialog 
box comes up, choose Selection in the Print range panel. 

Resetting the Alarm Count 

The total number of alarm messages from all connected RTUs is displayed at the bottom of 
the window. This counter accumulates regardless of whether Raw Data is enabled or disabled. 
To reset the alarm message count to zero, click on the Reset button in the bottom right-hand 
corner of the window. 
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Tools 

The Tools menu contains the following items: 

• Users… — displays the User Options window. This is where Metago Monitor users 
can change their passwords.  Also, this is where Metago Monitor Administrators can 
add and delete users. 

• Options… — displays the Options window. Only users with Administrator permission 
level will be able to modify parameters in this window. Some of the features contained 
in this window are alarm latching, web page access, and connection parameters. 

• Inhibited Alarms — this displays the Inhibited Alarms window. All alarm points that 
have been inhibited are displayed in the Inhibited Alarms display. 

• View Logs — Metago Monitor maintains a log of all alarm messages and database 
change events.  This log is kept in an internal database.  The View Logs menu option 
displays a window that allows for customizing and generating log reports.  The log 
reports are generated in .csv format, and are displayed as such, but can easily be 
imported into a spreadsheet application. 

• Clear Logs — The Metago Monitor log database will continue to expand as events 
and alarms occur.  In order to prevent this database from growing to an 
unmanageable size, it is recommended to export all logs to .csv for archiving 
purposes on a regular basis.  Once the logs are exported (using the View logs option), 
the Clear Logs option will delete all entries from the log database 

This chapter will discuss the options in the Tools menu. 

Users … 

A username/password combination is required to access the Metago® Monitor application. 
This username/password is independent from the WS3500 username/password that is used 
to issue controls. 

There are two levels of users: Administrator and User. Administrators can add and delete 
users, modify existing users, and change user levels. Standard users can only modify their 
own password. 

Adding a User 

Note: You must be logged in as an Administrator to add a user 

To add a user,  

1. Select Users… from the Tools pull-down menu. The User Options window appears.  

Chapter 
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Figure 6 User Options window 

2. Click the Add User button. The Add / Edit User window appears. 

 

Fill in the following fields on the General tab 

• First Name, Initials, Last Name — This is optional information about the user. 

• Username — The username must be a minimum of 1 character in length. 
The username is case sensitive. 

• Password — the password is a maximum of 8 characters in length. The 
password is case sensitive. 

• Confirm password — Re-enter the same password that was entered in the 
Password field.  This is to help prevent typing errors 

• Administrator — check this box if the user is to be an Administrator. If the box 
is left un-checked, the user is a standard (non-administrator) user. 
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Fill in the following fields on the Contact tab 

• Business Phone, Mobile Phone, Home Phone — This is optional additional 
contact information about the user. 

 

Fill in the following fields Notification tab 

• E-mail Address — The user’s e-mail address can be entered here for e-mail 
alarm notification.  The “send test e-mail” button will send an e-mail to the 
above address to verify that it is correct.  The “Schedule…” button allows for 
scheduling of what timeframes the user wishes to be notified about alarms 
via e-mail.  E-mail Notification rules allows for customization of the type of 
alarms the user wishes to be notified by e-mail.  The alarms can be filtered by 
severity, as well as by workgroup.  Click the “Schedule button to bring up the 
“Schedule” window. 
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In the Schedule window, select the hours during which to notify the user via 
e-mail.  The hours that are selected are indicated by an “X”. 

3. OK the Add / Edit User window. The new user will be displayed in the User List. 



  Metago® Monitor ⎯ Tools  

Metago Monitor — 994-T065 Rev G, April 2007  27 

Editing a User 

Note: An Administrator must be logged in to edit other users. If a non- administrator user is 
logged in, they may only modify their own information. 

To edit a user,  

1. Select Users… from the pull-down Tools menu. The User Options window appears.  

 

2. Select the user to be modified from the list. 

3. Click the Edit User button. The Add / Edit User widow appears, as described above, 
in the Adding a User section. 

 

Deleting a User 

Note: An Administrator must be logged in to delete a user.  The user that is currently logged in 
may not be deleted. 

To delete a user,  

1. Select Users… from the pull-down Tools menu. The User Options window appears.  
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2. Select the user to be deleted from the list. 

3. Click the Delete User button. A confirmation dialog box appears 

. 

4. Click OK to close the Confirm window. The user will be removed from the list. 

Changing Passwords 

An Administrator can modify any user’s password, while a standard user can only modify their 
own password. 

To change a password,  

1. Select User Options from the Tools menu. The User Administration dialog box 
appears.  

Note: If a standard (non-administrator) user is logged in, the User Administration dialog 
box is skipped, and the Change Password dialog is displayed immediately. 

2. Select the username in the list. 

3. Click the Change Password button. The Change Password window appears. 

 

4. Enter the current password, the new password, re-enter the new password for 
confirmation, and then click OK to save the new password. 

NOTE:  Administrators do not need the current password when changing the password of 
another user. 

Changing the user type 

Note: An Administrator must be logged in to change the user type 

To change the user type,  

1. Select User Options from the Tools menu. The User Administration dialog box 
appears.  
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2. Select the username in the list. 

3. Check or un-check the Administrator checkbox. 

4. Click Close to save the change. 

Options … 

To access the Options window, select Options in the pull-down Tools menu. 

Only users with Administrator rights will be able to modify any of the fields in the Options 
window. For non-administrator users, all the parameters in the Options window are read-only. 

 

Figure 7 Options dialog box 

The Options form is divided up into tabs 

• Alarms — On the Alarms tab, an Administrator can configure alarm latching and 
Alarm summary freeze timeout options. 

• Web — On the Web tab, an Administrator can configure the web server plug-in 
and enable or disable audible alerts on the web page. 

• Connection — On the Connection tab, an Administrator can configure the 
Metago® Monitor application to automatically attempt to restore a connection to 
specified RTUs at timed intervals. The Administrator can also configure the 
control timeout interval and heartbeat connection interval. 

• General — On the General tab, an administrator can enable or disable password 
complexity. 

• Notification — On the Notification tab, an Administrator can configure audible 
alarm notification, as well as e-mail alarm notification. 

• Modem — On the Modem tab the configuration for the interface to the dial up 
modem can be set. 
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Options – Alarms tab 

On the Alarms tab, an administrator can configure Alarm Latching and Alarm Summary freeze 
timeout. 

 

Alarm Latching 

There are two types of alarm latching — “Latch unacknowledged alarms” and “Latch alarms 
with comments”. To enable one or both of these features, select the checkbox in front of the 
text. 

If “Latch unacknowledged alarms” is checked, alarm points that have been in alarm and 
cleared, remain in the Alarm Summary display and Metago® Monitor web page until they have 
been acknowledged. 

If “Latch alarms with comments” is checked, alarm points that have comments which have 
been in alarm and then cleared, remain in the Alarm Summary display and Metago® Monitor 
web page until the comment has been deleted from the alarm point. 

Alarm Summary freeze timeout 

In the top-right corner of the Alarm Summary screen, there is an option to freeze the Alarm 
Summary display.  While the display is frozen, new alarms are not added to the Alarm 
summary.  This timeout is will un-freeze the display after the configured time, to prevent a user 
from unintentionally leaving the display frozen, and missing new alarms. 

Options – Web tab 

On the Web tab, an Administrator can enable or disable the web server plug-in.  

Checking the Enable Web Server plug-in allows users to access the Alarm Summary via a 
web browser on any PC on the same LAN as the Metago® Monitor PC. Along with enabling 
this feature, the Administrator can also define how often the web page will refresh, and 
whether audible alerts will sound when an alarm point changes state.  
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If the Web Server plug-in is checked, a hypertext link to the web page is displayed at the 
bottom of the sheet. A user may click on this hypertext link to view the web page. 

Options – Connection tab 

On the Connection tab, an Administrator can configure Metago® Monitor to automatically 
attempt to reconnect to specific RTUs at timed intervals. In addition to the AutoConnect 
feature, the Administrator can also configure the communication timeouts for a control 
response and a connection heartbeat. 

 

AutoConnect 

Every RTU may be configured for either manual or automatic connection. If an RTU is 
configured as autoconnect, at every user-defined AutoConnect interval, Metago® Monitor 
cycles through its list of RTUs and attempts to connect to any RTU that is configured as auto 
connect, but is not connected. While Metago® Monitor is attempting to AutoConnect to the 
RTU, the RTU will be displayed in blue in the RTU Summary display indicating a connection is 
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pending. When the connection is established, the RTU will be displayed in green. If the 
connection cannot be established, the RTU is displayed in red. 

To configure an RTU as AutoConnect, 

1. In the Connection tab, enter the time interval. 

2. Click on the AutoConnect button. The AutoConnect window appears. 

 
3. Select the RTU to configure as AutoConnect from the Manual Connect list, then click the 

“>>” (insert) button. The selected RTU(s) will now appear in the AutoConnect list.  You can 
select multiple RTUs by holding down the CTRL key while selecting RTUs from the list. 

4. Click Close to save changes. 

Communications Timeouts 

To compensate for slower network connections, an Administrator may configure the control 
response timeout and the connection heartbeat interval. On the heartbeat interval, Metago® 
Monitor sends a TL-1 RTRV-HDR message to the RTU to ensure that it is still connected. 
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Options – General tab 

On the General tab, an Administrator can configure the way Metago Monitor handles user 
password validation.   

 

User Options 

The “Enforce Password Complexity” checkbox enables / disables password complexity 
restrictions for Metago Monitor user accounts.  With the option enabled, the password must be 
a minimum of 8 characters, and must contain at least 2 alpha, 2 numeric, and one special 
character ( @  .  _  - )  
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Options – Notification tab 

On the Notification tab, an Administrator can configure certain additional methods that Metago 
Monitor can use to notify users of alarms.   

 

Audible alarm notification 

In addition to displaying the alarm points in the Alarm Summary display and Metago® Monitor 
web page, an administrator can configure distinct audible alerts for each alarm severity. 
Metago® Monitor provides default .wav files of synthesized male and female voices 
announcing the alarm severity, but any standard .wav files can be used. Only the audible of 
the highest alarm severity is activated. 

To enable this feature, check the Enable audible alert box. The Administrator can also have 
the audibles repeat at timed intervals. To do this, check the Repeat alert every box and enter 
the time interval you wish the audibles to repeat. 

To assign different .wav files for audible alerts, click on the Settings button. The Audible Alert 
Settings window appears. 
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Click on the appropriate file icon to select a .wav file for each alarm severity, when finished, 
click OK to save changes and close the window. 

E-mail alarm notification 

Another method that Metago Manager can use to notify users of alarms is e-mail notification.  
In order to configure e-mail notification, Microsoft Outlook must be installed on the Metago 
Manager computer.  In Outlook, a valid e-mail account must be configured, much like any 
other user would configure Outlook to access a mail server.  It is recommended that an e-mail 
account be created specifically for Metago Monitor use (i.e. 
metago.monitor@<corporate_email_server>). 

In addition to Outlook being installed, there is a third-party Outlook Advanced security patch 
that must be installed in order for Metago Monitor to be allowed access to Outlook.  This 
Outlook patch is available for download from Mapi Lab.  See the following links: 

Information: http://www.mapilab.com/dev/outlook_security/  
Download: http://www.mapilab.com/files/security_outlook.zip 

The first time Metago Monitor attempts to access Outlook to send an e-mail, the Advanced 
security window will appear.  Select the option to allow Metago Monitor to proceed, and also 
select the option to always take this action for this application. 

In order for e-mails to be sent from Metago Monitor, there must be users configured with e-mail 
addresses and schedules.  See Users section of this manual for details on how to configure 
this. 
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Inhibited Alarms … 

Alarms points that have been inhibited are removed from the Alarm Summary display and 
placed in the Inhibited Alarms display. To access the Inhibited Alarms display, select Inhibited 
Alarms from the Tools menu, or click the View Inhibited Alarms button on the Alarm 
Summary tab. 

 
Figure 8 Inhibited Alarms display 

The inhibited alarms are displayed in the list in same alarm colors as the Alarm Summary 
(refer to Table 1 Alarm Colors on page 14). 

There are two methods to un-inhibit the alarms. With the right mouse button, click on the alarm 
to be uninhibited in the list. A popup menu appears. Select Uninhibit. OR select the point in the 
list with the left mouse button and then click the Uninhibit Selected Alarm button. In both cases 
the point is removed from the display. 

View Logs … 

Logs are kept for each RTU that is connected via Metago® Monitor.  The logs are stored 
in an internal database in Metago Monitor.  The View Logs menu item allows a user to 
configure and generate a log report.  The exported log reports are in .csv format, which 
can easily be imported into a spreadsheet application for manipulation. 

Metago Monitor logs include all alarms from all configured RTUs, as well as Operations 
entries for acknowledging, commenting, and inhibiting of alarm points. 

Generating a log report 

To generate a log report,  

1. Select View Logs… in the Tools menu.  The View Logs – Generate Report window 
appears.  
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2. Select the appropriate search criteria as follows: 

• Search for… — select the type of log entry to search.  A search can include either 
alarms or operations.  “Alarms” includes all alarm messages from all RTUs 
configured in Metago Monitor.  “Operations” includes all acknowledgements and 
comments made on alarms by users, as well as the inhibiting of alarms. 

• Date Range — Select a date range to search by entering a start date and end 
date.  If this field is left blank, no date range will be applied, and all records will be 
searched. 

• SID — The report may be filtered so that only alarms or operations containing a 
specific SID are displayed.  If this field is left blank, all SIDs are searched. 

• AID — The report may be filtered so that only alarms or operations containing a 
specific AID are displayed.  If this field is left blank, all AIDs are searched. 

• Point Description — The report may be filtered so that only alarms or operations 
containing a specific Point Description are displayed.  If this field is left blank, all 
Point Descriptions are searched. 

• Location — The report may be filtered so that only alarms containing a specific 
Location are displayed.  If this field is left blank, all Locations are searched.  This 
search parameter is only available for Alarm searches. 

• Workgroup — The report may be filtered so that only alarms containing a specific 
Workgroup are displayed.  If this field is left blank, all Workgroups are searched.  
This search parameter is only available for Alarm searches. 

• Severity — The report may be filtered so that only alarms of the specified Severity 
(and higher) are displayed.  By default, all alarm Severities are searched.  This 
search parameter is only available for Alarm searches 

• Username — The report may be filtered so that only operations performed a 
specific user are displayed.  If this field is left blank, operations by all users are 
searched. 

3. Click the Search button to generate the report. 
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4. The Log Report Viewer window is displayed, containing the requested log records. 

The following are sample reports for Alarm, and Operations search types: 

 
 

 
Figure 9 RTU Log Report Samples 
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In Alarm log reports, the data is sorted into the following columns: 

• Timestamp — the time the log entry was generated. 

• SID — the system identifier (SID) of the alarm. 

• AID — the access identifier (AID) of the alarm. 

• Point Description — the point description of the alarm. 

• Location — the location (or CLLI code) of the alarm. 

• Work Group — the two-character workgroup of the alarm. 

• Severity — the severity of the alarm (CR, MJ, MN, RN, or CL), 

• Service Affecting — either SA or NSA. 

 

In Operations log reports, the data is sorted into the following columns: 

• Timestamp — the time the log entry was generated. 

• Action — what action was performed. Some possible action descriptions are ACK (an 
alarm was acknowledged), WEB_ADD/EDIT COMMENT (a comment was added to 
the point via the Online Alarm Summary web page), DEL_COMMENT (a comment 
was deleted from the point via the Monitor Alarm Summary page), and INHIBIT (the 
alarm point has been marked as inhibited). 

• SID — the system identifier (SID) of the alarm on which the operation was performed. 

• AID — the access identifier (AID) of the alarm on which the operation was performed. 

• Point Description — the description of the point. 

• Username — the user who performed the operation, i.e. added a comment, 
acknowledged an alarm, etc. 

• Comment — the comment that was attached to the alarm point.  This field is only 
present for comment-related operations. 

Clear Logs 

The Metago Monitor log database does not automatically purge old records.  In order to limit 
the size of this database, it is recommended that all data be exported to .csv files for archiving, 
and the log database cleared on a regular basis.  To do this, select View Logs and generate 
alarm and operation reports with no filter parameters, then select Clear Logs to purge the 
database. 

Options – Modem tab 

On the Modem tab, an Administrator can configure the serial connection properties for 
communicating with the dial-out modem.   
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Modem Options 

 Please note that the user will not be able to alter the modem properties when Metago 
Monitor is trying to dial out. 

• Port — the computer COM port where the modem is located 

• Data Rate — the serial data rate between the computer and modem 

• Data Bits — the number of data bits used in the serial connection 

• Parity – The type of serial parity used by the modem 

• Stop Bits – The number of stop bits used by the modem 

• Flow Control – The type of flow control used by the modem 
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Online Alarm Summary 

To access the Online Alarm Summary web page, it is recommended to use Internet Explorer 
5.5 (or above), or Mozilla Firefox, and cookies must be enabled. 

To access the Online Alarm Summary web page, enter the PC’s IP Address or network name 
in the Address field in a web browser. or click the hypertext link in the Options - Web tab. The 
Metago® Monitor Login page appears. 

 

Enter a valid Username and Password for Metago Monitor and click the Login button. The 
Online Alarm Summary page appears. 

Chapter 

9 
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Figure 10 Online Alarm Summary web page 

From the Online Alarm Summary page, the following operation may be performed 

• Acknowledge and unacknowledge alarms 

• Acknowledge all alarms 

• Add, edit, and delete comments. 

• Access the InSite web page for a particular RTU by clicking on the hyperlink to that RTU 
under the Monitored RTUs list.  

Acknowledging Alarms  

To acknowledge an individual alarm, click on the Alarm Ack icon with the left mouse button. A 
green check mark appears on the Alarm Ack icon indicating the alarm has been acknowledged. 

To acknowledge all the alarms, click on the ACK ALL button. 

Unacknowledging an Alarm 

To unacknowledge an acknowledged alarm, click on the Alarm Ack icon with mouse button one. 
The green check mark will disappear. 
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Adding a Comment  

To add a comment to an alarm point: 

1. With the left mouse button, click on the Comment column of the alarm in the list. The Edit 
Comment dialog box appears. 

 
2. Type in Comment in the space provided. 

3. Click Send Request to save the comment. A confirmation window appears indicating that 
the request has been sent. 

 

4. Click the Close Window button. A comment icon will appear next to the Alarm point. 

Deleting a Comment 

To delete a comment to an Alarm Point, do the following: 

1. With the left mouse button, click on the Comment icon associated with the alarm point. 
The Edit Comment dialog box appears. 

2. Delete all text from the Comment area. 



Metago® Monitor —Online Alarm Summary  

44  Metago Monitor — 994-T065 Rev G, April 2007 

3. Click Send Request to delete the comment. A confirmation window appears indicating 
that the request has been sent. 

4. Click on the Close Window button. The comment icon will be removed from the Alarm 
point. 

Accessing the InSite web page 

To access the InSite web page for a particular RTU, click on the hyperlink text to that RTU 
under the Monitored RTUs list. If InSite is enabled for that RTU, the InSite web page will 
be displayed. 

Logging Off 

To log off of the Online Summary page, either close the Internet Explorer window, OR 
click the LOGOUT button. 
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